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NON-TECHNICAL SUMMARY
This report presents a review of the photogrammetric and website training for three
community heritage groups. The project was designed to provide the groups with the skills to
generate 3D models of objects and sites and to share these via online databases. The groups
had varying degrees of success, with most being able to generate 3D models from digital
photographs. The groups have constructed websites for sharing their data, with limited
material uploaded to date.
In some cases a lack of basic computing knowledge among group members hampered the
success of the project. Any future projects should start from first principles of managing and
transferring computer files. A significant outcome of the project has been the bringing
together of the groups and their skills and abilities. As a result the groups have agreed to work
together to improve their results.
The project was funded as part of the East Peak Industrial Heritage Support Programme, which
is jointly funded by English Heritage, Defra and the European Union.
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INTRODUCTION
Three community groups took part in photogrammetric training project by ArcHeritage as part
of the East Peak Industrial Heritage Support Programme Photogrammetry and Digital
Recording Project. The participants were the Roggins Local History Group based in Silkstone,
Friends of Skelmanthorpe Textile Museum, and Friends of Wortley Top Forge. All three groups
were taught the same skills over the course of three individual photogrammetry workshops
and one website design workshop.
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AIMS AND OBJECTIVES
The main aim of the project was to work with the community groups to help them to develop
and maintain on-line, digital records of industrial sites from their local areas, and to explore
how different modern technologies can be used effectively (and affordably) to record and
monitor industrial heritage sites on a local scale.
The key objectives of the project were to:









Deliver a series of practical workshops on the use of photogrammetry and other
techniques for digitally recording and modelling industrial heritage sites to 3
community groups across the East Peak (a minimum of 3 days, or 6 half days, per
group). These should include at least one site recording visit, with follow-up technical
support sessions.
Produce information sheets and/or guidance notes to accompany the workshops (to
help groups to continue to develop their skills in future) including advice on the use of
different techniques (or different software) and when these may or may not be
suitable for different sorts of groups and industrial heritage sites.
Oversee the development and launch of up to three new on-line industrial heritage
gazetteers or catalogues (which may be connected to existing websites or other online collections) by each group, and advise the groups on ways of developing and
continuing their projects.
Review each group project after 6 months of completion to assess subsequent use and
assist with any further technical queries or problems encountered by each group.
Produce a final report on the whole project to advise other community groups and
potential funders as to what worked well, and the potential for developing similar
projects elsewhere in future. This report should include details of any problems
encountered along with advice on different approaches, copyright and software
issues, data storage – including any potential issues with the use of data clouds - and
the potential for commercial applications (for instance, by museums, heritage centres
or charitable bodies) so that the report is relevant to as many different sorts of
heritage groups as possible.
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METHODOLOGY
The project comprised four workshop sessions for each of three community heritage groups
involved in the project. The groups that took part in the project were:




The Roggins Local History Group;
The Friends of Skelmanthorpe Textile Museum; and
The Friends of Wortley Top Forge.

The four sessions comprised small group instruction on principles and methods for taking
photographs, the use of photogrammetric software, development of websites and
troubleshooting. The groups were provided with information sheets on the principles and
methods to be used for the project. The information sheets are provided in Appendix 1.
Attendance sheets for the workshop are provided in Appendix 2.
The project brief is provided in Appendix 3. ArcHeritage’s method statement is provided in
Appendix 4.
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WORKSHOP 1 - PHOTOGRAMMETRY
The first photogrammetry workshop was a practical introduction to the basic skills needed to
create a 3D model from a set of images. Two software packages were explored, 123D Catch
and Agisoft Photoscan. The groups were shown how to take images that would be suitable for
both software packages. Emphasis was placed on the distribution of the camera images and
the movement of the camera around the object rather than moving the object itself.
Consideration was also made as to the suitability of certain types of object. Highly reflective
objects would not be suitable and objects with low levels of pattern, our tutorial example
being a white milk container, would equally be unsuitable for recording. It was emphasised
that lighting would have a dramatic effect on the success of the project and that it was
necessary to move around the objects freely to collect enough images to build a full 3D model.
Considering these factors it was decided that the best place to take images was outside in the
shade.
The group’s interests varied considerably and there was scope for individual tailored classes
on specific techniques relevant to the group’s objectives. The initial workshop was held at the
group’s premises to facilitate individual needs and specific requests, addressing unique
problems that might become apparent when working with different objects. The
Skelmanthorpe group had the most difficult task; many of the objects they wished to record
were highly glazed complicated forms. However, they were able to produce a nice example of
objects contained within a bowl. Complicated objects presented as a collection in the simple
geometric form of the bowl provided a solution to some of the issues they encountered.
The results of the initial workshop were encouraging with all groups being able to produce a
basic 3D model from their own data. All groups received handouts which explained the basic
rules and a work flow for both software packages. 123D Catch is a free piece of software and
could be downloaded by any member of the group, it was also provided on disk for those in
attendance. Copies of Agisoft Photoscan were provided to the group in a demo format to
facilitate practicing the techniques demonstrated in the workshop.
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WORKSHOP 2 - PHOTOGRAMMETRY
The second workshop was timed to be at least two weeks after the first allowing time for
group members to attempt their own projects. The workshop was principally focused on
technical aspects and involved a session with the computer software to gain an understanding
of the processing of the data. Attendees brought projects they had attempted and showed off
some of their models. Nearly all projects had some issues with a few very good attempts,
albeit not of the subject matter originally intended. The successful projects focused on objects
individuals had at home, with a perfect 3D example of a garden statue. It should be noted that
the objects 3D recorded at the individuals own home exhibited better space and lighting
setups.
A discussion as to why some projects had functioned and others had not, became the focus of
the first part of the workshop. Most of the issues with the projects were caused by either a
lack of images to complete the model, or from out of focus pictures. The difficulties with out of
focus images were predominantly caused by camera shake, rather than the focus of the
image. Projects photographed in low light conditions were much more likely to exhibit blurred
images than those taken outside with the same camera. This problem was exacerbated by the
requirement to switch off the image stabilising function of the camera, and also by higher ISO
settings needed in low light. A high ISO setting will cause graining and digital noise which can
cause undesirable results in the project. These issues were discussed and solutions proposed
involving the use of a tripod or if possible moving the object into a brighter location.
The groups were then introduced to some more advanced features of the software; all groups
seemed to have better results with Agisoft Photoscan rather than 123D Catch and so a full
functioning copy was purchased for each group. The success the groups had with Agisoft
Phpotoscan seemed to be due to the software’s ability to align more images than 123D Catch.
Agisoft Photoscan was more forgiving when it came to blurred images and would attempt and
succeed in working with images that were slightly less than optimal. The group were taught
how to clean up the results of the project, by editing the 3D mesh inside the software. This
enabled them to remove bad and extra geometry from their models to produce cleaner 3D
meshes. They were also taught about blending the images to create textures and the different
settings to achieve this. Textured models often look more accurate than un-textured models.
The texture provides an extra level of detail, which can mask issues with the underlying
geometry, most of the groups projects were enhanced when texturing was applied, and some
minor geometric issues were no longer visible.
The groups then proceeded to create 3D PDF outputs which could be shared with others. The
concept of scale was discussed and how to incorporate some form of scale bar into the
models. This was indented to allow the groups to build up and share a catalogue of 3D models
with other interested parties. The overall objectives of the project and the group’s individual
requirements were discussed to help focus their efforts on producing some content for the
website environment.
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WORKSHOP 3 - WEBSITE TRAINING
The groups were given training to understand and create web based content. The focus of this
session was to provide an open source solution to the access and design of a web based
interface, which would allow them to host a catalogue of their models and projects online. The
training covered the full process of creating and maintaining a web presence for the 3D
projects the groups were attempting. Basic use of Wordpress and Google docs was
demonstrated within the context of creating an online heritage resource. The groups have
successfully created the framework for an updatable online resource for their projects
although most have yet to add significant amounts of content.
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WORKSHOP 4 - PHOTOGRAMMETRY
The final workshop session provided the groups with follow up technical support. It was held
several weeks after the initial sessions to ensure that the groups had attempted several
projects. The session was jointly held for all three groups at the ArcHeritage offices. Many
group members came with digital files that they had been working on. These files were loaded
up on to the ArcHeritage computers and examined for potential issues. This session gave the
groups the chance to ask specific questions relating to the issues they had experienced. The
results from their projects were generally quite good, the principles of the data collection had
been applied well and some of the challenges from the second session appeared to have been
addressed and corrected.
There were still difficulties with some of the projects which would need to be addressed. Some
problems were the result of a lack of images to cover the model; others were the product of
unwanted objects in the images. Advanced techniques were discussed and demonstrated in
this session that would help solve the problems the groups were having. The ability to mask
out unwanted data on the photographs was explored as a potential solution to poor image
alignment and excessive geometry creation. Live session demonstrations on actual projects
created by the groups, demonstrated that masking could help solve the issues they were
experiencing. The session also reiterated on all of the basic principles including file locations
and general PC use. One interesting point of note is that all three major operating systems
were being used by the groups, Windows, Mac and Lynx. This session attempted to address
the differences and similarities between the operating systems in respect of how the
photogrammetry software functions, and the file structure that each one uses.
Jointly holding the session for all three groups proved to be advantageous. Between all three
groups there was enough of an understanding of the technology to solve most of the issues
they were experiencing. After this session the three community groups have agreed to work
together to help each other produce better results.
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CONCLUSION AND RECOMMENDATIONS
The project set out to teach three community groups how to 3D record their heritage interests
using consumer grade digital cameras and to present these as 3D models online. There are
several aspects to this project that are needed for it to be successful. Computer literacy
amongst the groups needs to be of a standard that will facilitate ease of use of the software. In
the early stages of the project some individuals indicated that they had little or no contact
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with computers, however given time they were able to pick up the necessary skills to create
the correct file directories and run the software to produce 3D projects. Future projects of this
type would benefit from a session in basic computer use for those that have had less
experience using them.
Camera shake and low light conditions remain a problem, particularly for the Friends of
Skelmanthorpe Textile Museum. The cramped nature of the museum makes it very difficult for
them to photograph in the ideal conditions. A solution would be to use a tripod and adjust the
camera functions to match the lighting conditions. This does start to move the project from an
easily accessible technique towards setting up a suitable studio environment that also requires
the use of the advanced or manual settings on the digital cameras. It would be fair to say that
most people, who have digital cameras, seldom if ever, use any of the manual settings. Adding
this level of complication would make this technique less accessible to community groups
without volunteers experienced in working with digital cameras. Another consideration might
be to turn on the image stabilising function of the camera and evaluate if these do have a
profound effect on the accuracy of the results. Even if this does produce slightly inaccurate
geometry does this really matter? The purpose of the project may not require the geometry to
be perfect; by the time it is hosted and viewed online it may be the primary concern is its
presence online.
The interaction of the groups in the third session was particularly encouraging; they have
arranged to meet up in Silkstone at the Bramah Gallery to continue the 3D recording and to
work out any problems using their combined knowledge on the subject from across the
groups. This is a valuable consideration for future projects of this type perhaps arranging
teaching in larger groups, or having a dedicated workshop that combines the knowledge of
more than one group working with the same techniques.
Further considerations
Although this technology offers a range of exciting opportunities to community groups,
consideration also needs to be given to the often complicated legal issues that are developing
around this form of recording, and in particular to issues of copyright surrounding digital
models and 3D printing. The technology is new and therefore these issues are still being
debated. They should not been seen necessarily as problems, but they still require
consideration and may result in certain organisations choosing either not to use the
technology at the present time (until these issues are more clearly resolved) or limiting what
they choose to create models of and how these models are used and distributed.
The first consideration in relation to the use of 123D Catch is that the modelling software can
be freely used, but users do not maintain the overall control or copyright for the uploaded
images or models produced from the data. Data is uploaded to a cloud which is owned and
controlled by Autodesk and can therefore be re-used by the company at any time, including
for commercial purposes. This may cause problems if the subject of the model is of a sensitive
nature, if the person creating the model does not own the subject, or if the subject could be
considered commercially valuable (such as a well known or iconic object or site, e.g. the Crown
Jewels or Nelson’s Column). These issues do not apply to models created using Agisoft as the
data for these models remains on the computer and therefore in the direct control of the
person creating the model.
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The second consideration, which applies to both pieces of software, is the issue of ownership
and copyright of a model. The differences between creating standard digital 2D images and 3D
images in terms of copyright have not yet been fully established. In general, the person
creating the model must obtain the site or object owner’s permission. However, the position is
unclear for modelling objects in the public domain, such as objects or buildings that are in a
public place or in places that are open to public, or that can be viewed from a public right of
way. For example, to 3D record an object whilst visiting a museum and then create a model
(either digital or physical) is likely to infringe copyright. But if it is done with the museum’s
permission then this should be ok, providing the museum owns the object or has permission
from the owner to 3D record the object. Equally, modelling architectural detail on a privately
owned building is also likely to infringe copyright (even if the data is captured from a public
right of way) and so the owner’s permission should always be obtained.
If digital images are created solely for personal research copyright is unlikely to be a problem.
However the distribution of models on the internet, or via 3D printing may well infringe more
copyrights or privacy (particularly in the case of certain buildings) and are likely to require the
express permission of the original owner of the site or object.
These issues are not necessarily prohibitive, but do need to be addressed in the early stages of
any project, to avoid potential problems later on. The key questions to answer before
conducting the project would be; do we own the object? If not do we have permission to do
the survey from the owner? And are we concerned about the loss of copyright over the
model?
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3D point cloud of the bellows at Holyandswain Nail Forge, generated in Agisoft Photoscan

Panoramic image of the Nail Forge
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Panoramic image of the ground floor of the Skelmanthorpe textile heritage unit

Panoramic image of the upper floor of Skelmanthorpe textile heritage unit
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Photogrammetry practical – capturing photographs of your subject
Photogrammetry is a technique for producing a 3D model of an object or space using a set of digital
photographs. This practical will guide you through the steps involved with capturing images of your
subject, and what factors you should consider when planning your shoot.

Camera and settings:






Use a digital camera with reasonably high resolution (5 Mpix or more).
If possible, use wide angle lenses rather than telephoto lenses, as they are better for
reconstructing spatial relationships between objects.
Insure constant light conditions for all your photographs as inconsistent lighting will cause
errors in your model.
o DO NOT USE A FLASH, as this will create unique lighting conditions for each
photograph.
o Make sure none of your photographs are overexposed or underexposed.
Do not crop or edit the images in any way, as the modelling software can only use unaltered
photographs kept exactly as downloaded from the camera.

General subject considerations:










Make sure you have plenty of overlap at multiple angles for your photographs to add as much
detail to your model as possible (about 60% overlap is good).
o More photographs are better than not enough, so if in doubt keep shooting. You can
always discard some shots when processing your model.
o If there are objects blocking the view of your model, or aspects of the model that
block other areas, tighten the intervals between viewpoints.
Capture important features from multiple viewpoints (3 or more), with both oblique and
straight on shots.
Avoid symmetrical, repetitive objects or blank/featureless walls – the software will have
difficulty in recognising one part of your subject from the next. Add identifiable detail to your
subject if necessary (e.g. numbered photographic targets, or distinctive coloured tape on blank
walls).
Avoid transparent, glossy or reflective surfaces as these objects will confuse the
photogrammetry software.
Shiny objects can be photographed under a cloudy sky, but avoid really shiny objects entirely.
No moving objects. Make sure that you subject does not move, or that there are no moving
objects within your subject area.
If you want to make measurements based on your model, locate at least two markers that are
a known distance apart on your model, or place a fixed scale within your subject area.
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Photographing an object:



Capture your subject as a whole by walking around the model before capturing detailed shots
of specific features – each feature should be visible in at least 3 shots.
Do not move objects to get different views of the model.

Photographing a room:




Walk around the perimeter of the room, taking shots of the opposite walls.
When taking photographs of ceilings and floors, make sure you have at least 50% of an overlap
between the floor and ceiling.
If you need to model multiple rooms, it is best to treat each room as a separate project, and
later combine them using 3D modelling software.

Isolated object (Incorrect)
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Photogrammetry practical – Autodesk 123d catch
This practical will guide you through using Autodesk 123d catch software to process digital photographs
by photogrametry, to produce a 3d model of an object or space.
To use this software you must be connected to the internet, as the actual processing of your digital
photographs is undertaken by Autodesk themselves.

Uploading your photographs:
The first thing you will need to do is upload your digital photographs.


Click on “Create a New Capture” icon on the top left corner of the window.

Click here to upload
photographs



Before you can load your images, you will be directed to a sign in screen with your account
details. If you haven’t created an account with Autodesk, you will need to do this before you
can proceed any further.



After signing in, you will be directed to a file explorer window where you can select images to
send to Autodesk to build the model (up to a maximum of 70 photographs).



Click “Complete Project” once you have uploaded all your photographs. Autodesk will send
you an email once they have finished processing your model and it is ready to download.
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Click here once you have
uploaded all your photographs

Navigating your model
Autodesk will send you an email with a link to download your processed model. You will need to save
this to a suitable location on your computer.



Once you have downloaded the file sent to you by Autodesk, find its location using explorer,
then double click on the file to open the model.

Once you have opened your model you will see a tool-bar at the top of the screen, below which will be
the model itself, and thumbnail images of your photographs along the bottom of the screen.

Toolbar

Photograph list

If it has not been possible to process any of your photographs for any reason, it will have a warning
symbol

at its top right corner. It may be possible to re-process these images by carefully matching

EPIP Photogrammetry recording
ArcHeritage Report

Report No 2013/26

ArcHeritage

17

key points between photographs; you can then re-send these images to Autodesk to incorporate into
the model after careful comparison of key points between photographs.



To move around within your model, you will need to use icons on the toolbar located at the
top of the screen.

o

Use the

icon to orbit around your model.

o

Use the

icon to more your viewpoint within your model.

o

Use the
within

icon or your mouse wheel to zoom in and out
your model

Cleaning your model:
There may be elements captured by your photographs that you do not want in your model. You can
delete these excess features to have a better view of your subject.



In the toolbar, select parts of the model using either the “Rectangular Selection” icon
the “Lasoo Selection” icon
.



Press the delete key on your keyboard once you are happy to remove a selected feature.

or

Exporting your model:
You can produce a video footage of your subject which you can share with others or upload to the
internet. You do this by marking a frame within the model at specific viewpoints in the order in which
you want your video to proceed:

Click here to save export your
video footage

Click here to capture a
keyframe for video footage
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Photogrammetry practical – Agisoft Photoscan
This practical will guide you through using Agisoft photoscan software to process digital photographs by
photogrametry, to produce a 3d model of an object or space.

Getting started:
Once you have installed and opened the software, you should have a screen that looks like this:

The majority of the tasks you will need to undertake in this software are undertaken via the “Workflow”
tab on the command bar. You will notice that the majority of the options under this tab are currently
greyed out, these will become available for you to use as you proceed from one step to the next.

Adding your photographs:
The first thing you will need to do is upload your digital photographs, so that the software can use the
images to build a model of your subject.



Click on the “Workflow” tab on the command bar, followed by either “Add Photos” – whereby
you can select individual images to upload, or “Add Folder” – which lets you add a whole folder
of photographs in one go.



Once you have navigated to the relevant file and selected your photographs, click on the
“Open” icon. You will now notice that all your photographs are visible along the bottom of
your screen.
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Aligning your photographs
Aligning your photographs will make the software calculate where each of your photographs were taken
in relation to each other, and create a “point cloud” of the solid objects within the model.



Click on the “Workflow” tab on the command bar, followed by “Align Photos”. This will bring
up a window where you can choose the accuracy of your alignment.
o For the purposes of this practical change the accuracy using the drop down list to
Medium, as this will take less time than the higher settings.



After clicking “Ok” to proceed, a progress indication window will appear which will give you an
estimated time to complete the work.

Once the program has finished aligning your photographs, you will see the “point cloud” appear,
showing the locations from which your photographs were captured. You can move around this point
cloud to see the different elements by clicking and dragging on the screen with the left mouse button to
rotate your viewpoint; change your viewpoint location by clicking and dragging with the right mouse
button, and if your mouse has a scroll roll, use this to zoom in and out from the model. You can also
switch off the photographs’ locations by clicking on the
icon.
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Building geometry (connecting the dots)
The next step will be to connect all the individual points of your model with a 3d polygon, covering all
the surfaces of your subject.



Click on the “Workflow tab on the command bar, followed by “Build Geometry”. This will bring
up a window where you can modify your target quality – which will determine how “lifelike”
your model will be. Bear in mind however, that the higher this setting the longer it will take to
generate the model (this can take several hours at its highest setting, depending on how many
photographs you have taken), and will require very high RAM hardware (at least 16 M).
o For this practical, change the target quality to Low, then click “OK”. The progress bar
then will give you know an estimate of the time to process the data.

Cleaning your model:
Once you have built your geometry, you may find that there are excess 3d polygons surrounding your
model, blocking the view of your subject. You will need to clean your model to delete excess features
so that you can have a better view of your subject.



Navigate around your model as described in the previous section, insuring that the navigation
symbol
is selected.



To select any elements you want to delete from your model make sure one the following icons
is selected:
Rectangle Selection

Free-form Selection
Circle Selection



Click and drag on elements of your model, then press the “Delete” key to remove any
unwanted features.

Build texture:
You can give your model a more realistic look according to the textures recorded in your photographs.




To do this, click on the “Workflow” tab on the command bar, followed by “Build Texture”.
When the “Build Texture” window appears, select either the “average” or “mosaic” blending
mode, then press “Ok”.
o Mosaic – this creates textures based on overlapping your photographs to get the
colour of a given point.
o Average – this creates textures based on averaging the colour value of a given point
from all the photographs of that point.
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Try using both texture techniques to compare which is best for your specific model. You may find one
to be more appropriate depending on the light conditions when taking your original photographs, or if
there are errors in the model.

Exporting your model:
You can export your model to enable anyone to view it in an Adobe PDF document. This is particularly
useful if you want to share your model with someone without Agisoft Photoscan software, or if you
want to upload your model on the internet.




To do this, click on the “File” tab on the command bar, followed by “Export Model”.
A window will then appear for you to navigate to the appropriate folder to save your model.
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1 OVERVIEW WEBSITE TRAINING

1.1 Background
This project has been developed on behalf of ArcHeritage in order to meet the requirements for a
framework online catalogue system for use by community archaeology groups within the purview of the
East Peak Innovation Partnership (EPIP). Full details of the requirements are available in the tender
document produced by ArcHeritage for submission to EPIP (Appendix A). The catalogue system is
required in order to allow the community groups to make their records available to the wider public.
Henceforth the community groups shall be referred to as internal users, the public as external users.

1.2 Outline Requirements
The outline project requirements which were extracted from the tender document were as follows:









that the system shall provide a searchable interface for records
that the system shall be capable of correctly displaying multiple data types
that the system shall be capable of generating an embedded map based on a records
geographic coordinates
that the system shall have low maintenance overheads
that the system shall be easily extensible and modifiable to meet each groups needs and for
potential future adoption by groups not covered by the current project
that the system will require minimal resource commitments (at most a 2 day development
period and be based on freely available platforms)
that relevant technical documentation and manuals shall be produced

2 DESIGN & IMPLEMENTATION

2.1 Design Overview
The primary project design was based on the utilization of freely available data hosting services which
provide developer APIs. These services would form the basis of a basic flat, one table database which
would provide internal users with a robust and low maintenance method for creating, editing and
deleting their records.
A simple web interface hosted on a user group's own web host would then serve to allow external users
to search and view the records, presenting them in a familiar and readable format.

Fig 1. Basic system architecture

The platform chosen as the data host was Google's Drive suite of file storage and document
collaboration tools. A Google Spreadsheet is used as the mechanism to for data entry, editing and
storage. This was chosen as providing an immediately familiar and easy to use method for the user
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groups to catalogue their data while also providing a well documented and well supported method for
that data to be passed to other applications.
Web Hosts will be defined on as-needs basis in order to best suit the requirements of individual groups
(which may already have their own established hosting providers or may need such services set up for
them). In order to account for this the web interface for external users was created using standard PHP
and Javascript with minimal use of additional frameworks and libraries. The only additional files
included are the Zend Gdata files which are a library of functions designed to interact with the Google
Data API.

2.2 Implementation
2.2.1 Setting up the Data Host
Once the data to be catalogued has been defined it must be transferred to the data host. In order to do
this a Google account is required. Once obtained a new spreadsheet must be created (Drive->Create>Spreadsheet ) and renamed appropriately.

Fig 2. Creating a new spreadsheet

The first row in the sheet is the header row, this is required to define the data types being entered
which allows the PHP functions to identify and act appropriately on the information they receive. No
specific naming conventions are required but some example labels are:
Name

Type

Description

Image

Text

Any column which contains the URL of an individual image file

Site No

Integer

A column containing site identifier numbers

BNG

Text

A column containing British National Grid Coordinates for the site or
object being recorded

For a table of suggested labels see Appendix B.
EPIP Photogrammetry recording
ArcHeritage Report

Report No 2013/26

ArcHeritage

24

Once the data types have been established data being entered in individual columns can be validated (
Data->Validation ) against a validation rule . This defines a particular number, word or, perhaps more
usefully, a list of words against which internal user entries can be checked ensuring consistency in the
dataset.

Fig 3. Creating data validation rules

Once the spreadsheet has been created and populated it must be made public in view only mode ( File>Share ) in order to allow it to be accessed without requiring authorization. Google employs the OAuth
protocol when accessing a users private data and it was judged that the additional development
overhead of allowing for this was unnecessary given the limited time available and the fact that making
the document public would not be exposing the internal users to any risk. Once made public it the sheet
must be published ( File->Publish ) in order to obtain a feed to the data. There are several feed types
available however CSV was chosen for this implementation due to the relatively uncomplicated
requirements for the project and the robustness, ease of use and low bandwidth requirements of CSV
data.

2.2.2 Setting up the Web Interface
2.2.2.1 File Structure
The web interface consists of three pages – all_records.php, search_records.php and view_record.php –
which display records to the external user. These pages are populated with html by functions called from
gsdb-php.php, which contains almost all the functions required by the interface. Additionally the gridutils.js javascript library – obtained under a free license from www.howtocreate.co.uk – is used by
view_record.php to transform BNG coordinates into Long/Lat coordinates and the galleria-1.2.8.min.js obtained under a free license from galleria.io – is used to provide the image gallery for the same page. A
single CSS file provides the visual theme for all the pages so the visual appearance of the catalogue is
relatively easy to modify.
The three interfaces pages are held in the top level gsdb folder with the Javascript, CSS and PHP
functions file are held in sub-folders. This is to ensure that, even though the current file count is quite
small, it would be easy to extend the application while retaining a coherent structure.
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Fig 4. File structure

2.2.2.2 Code Description
Once the CSV feed is obtained a standard PHP function for populating an array from a CSV file is used:
function csvToArray($delimiter) {
//the public link to the google feed
$file=
'https://docs.google.com/spreadsheet/pub?key=0AoQQqCMa5wjdGhwb1dnbDExeVRYVEFRdUNycXpNZmc&output=cs
v';
//extract the document key
$split_file = strstr($file, 'key');
$pieces = explode("&", $split_file);
$subpieces=explode("=", $pieces[0]);
$key=$subpieces[1];
$arr= array();
$failed=false;
//try to connect using Zend
try
{
//create a new Cell Feed to retrieve the first
row of the spreadsheet
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//the first row is the header row and is not
returned by a worksheet feed
$spreadSheetService
Zend_Gdata_Spreadsheets();

=

new

$query = new Zend_Gdata_Spreadsheets_CellQuery();
$query->setMinRow(1);
$query->setMaxRow(1);
$query->setSpreadsheetKey($key);
$feed = $spreadSheetService->getCellFeed($query);
$i=0;
//pass the header row into an array
foreach($feed as $cellEntry) {
$arr[0][$i]=$cellEntry->cell->getText();
$i++;
}
//create a new worksheet
spreadsheet data

feed

to

retrieve

$query
=
Zend_Gdata_Spreadsheets_DocumentQuery();

the
new

$query->setSpreadsheetKey($key);
$feed
=
>getWorksheetFeed($query);

$spreadSheetService-

$entries
=
>getContentsAsRows();

$feed->entries[0]-

$i=1;
$j=0;
//pass the data into an array
foreach ($entries as $entry)
{
foreach($entry as $cell)
{
$arr[$i][$j]=$cell;
$j++;
}
$j=0;
$i++;
}
}
//if the zend connection fails flag it as failed
catch (Exception $e)
{
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$failed=true;
}
//try to connect using cURL/fopen if needed
try
{
//check if the zend connection failed
if($failed==true)
{
//check if you can use fopen on external
urls
if
FALSE) {

(($handle

=

fopen($file,

'r'))

!==

remove

the

$i = 0;
//iterate through the csv,
commas and add the data to an array
while (($lineArray =
$delimiter, '"'))!==FALSE) {

fgetcsv($handle,

0,

for ($j = 0; $j < count($lineArray);
$j++) {
$arr[$i][$j]

=

$lineArray[$j];
}
$i++;
}
fclose($handle);
}
//if fopen is not available
use cURL to
retrieve data, store it in a temporary file and
then read it
else
{
$ch = curl_init();
curl_setopt($ch,

CURLOPT_URL,

curl_setopt($ch,

CURLOPT_GET,

$file);
1);
curl_setopt($ch, CURLOPT_HEADER, 0);
curl_setopt($ch,
CURLOPT_RETURNTRANSFER, TRUE);
curl_setopt( $ch, CURLOPT_MAXREDIRS,
10 );
$str = curl_exec($ch);
curl_close($ch);
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$temp = tmpfile();
fwrite($temp, $str);
fseek($temp, 0);
$i = 0;
while (($lineArray = fgetcsv($temp,
0, ',', '"'))!==FALSE) {
for
($j
count($lineArray); $j++) {

=

0;

$j

$arr[$i][$j]

<
=

$lineArray[$j];
}
$i++;
}
fclose($temp);
}
$failed=false;
}
}
//if no
message

connection

is

possible

output

error

catch (Exception $e)
{
echo 'Failed to connect to server. Error:'.$e;
}
return $arr;
}

This array, commonly named $data in code, forms the basis on which all the sorting and identifying
required for the catalogue system is based. The $feed variable in the csvToArray function contains the
the URL for the spreadsheet being used as data source, this is the only point at which this URL needs to
be entered in order to set up the web interface to connect with the data source. The function then
takes this URL and makes three different attempts to establish a connection. First it attempts to build a
connection using the Gdata library, if this fails it attempts to use the php open function to read in from
the external url, if this fails it attempts to use cURL to transfer the spreadsheet to a temp file on the
server and reads it from there. If this fails then an error message is outputted.
Once the data has been read in and returned by the function it is put into a session variable with a
specified time-out period. This is to increase response times by keeping the returned data in memory
on the server.
if (isset($_SESSION['LAST_ACTIVITY']) && ((time()
- $_SESSION['LAST_ACTIVITY']) > 300)) {
// last request was more than 30 minutes
ago
session_unset();
$_SESSION variable for the run-time
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}
$_SESSION['LAST_ACTIVITY']
last activity time stamp

=

time();

//

update

//check if the data feed has already been pulled
and stored in a session variable, if not do so
if(isset($_SESSION['data']))
{
$data=$_SESSION['data'];
}
else
{
$data=csvToArray(',');
$_SESSION['data']=$data;
}

The two key functions in producing content for external users are pgDisp and prntRec. Breaking it down
in detail the pgDisp function takes the data feed and several parameters (whether that is the entire
feed or a subset based on user search terms) and, based on the parameter values, returns a table which
lists records and certain key entries along with a link to the full record. The parameters defined in the
function are
function
pgDisp($rmvCol,
$imgCol, $pg, $pgC)

$data,

$srcResults,

where $rmvCol is the list of columns not to be displayed, $data is the $data feed, $srcResults is an array
containing the ids of rows which match a user's search, $imgCol is the id of the first image column (
used for generating a thumbnail image ) , $pg is the page to be displayed and $pgC is the number of
records to be displayed per page.
foreach($rmvCol as $rmv)
{
if($rmv==$j)
{
$check=true;

For each entry in the $rmvCols array check if its value is equal to that of the current row, if it is set check
to true.
if($imgCol!=false&&$j==$imgCol){
$img=$data[$i][$j];
$itest=substr($img, 0, 4);
if($srcResults==1)
{
$filename='thumb_rec_'.$i.$j.'.jpg';
}
else
{
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$filename='thumb_rec_'.$srcResults[$i].
$j.'.jpg';
}
$pieces=explode("<", $img);
foreach($pieces as $str){

$str=str_replace(">", "", $str);

Generate a file name and if this column is the first image column, remove any html tags.
if(strstr($str, "img"))
{
$pieces2=explode('"',$str);
foreach($pieces2 as $str2)
{
if(strstr($str2,

"http"))

Remove the last four characters (.jpg) from the URL and replace them with '_t.jpg'. This is done to
generate a thumbnail image for the first image in a record, Flickr identifies it's thumbnail images with
'_t'.
if (file_exists('Images/thumb/'.$filename)){
$html=
src="Images/thumb/'.
$filename.'"></td>';}

$html.'<td><img

If a thumbnail file already exists use it.
if(strstr($img, "flickr"))
{
$p=substr($str2, 0, -4);
$p=$p."_t.jpg";
$html=$html.'<img src="'.$p.'">';
}

If the file is on flickr use the flickr thumbnail.
elseif(function_exists('imagecreatefromjpg'))

{
$imgt
=
imagecreatefromjpeg($img);
$width = imagesx( $imgt );
$height = imagesy( $imgt );
//
calculate
thumbnail size
$new_width = 100;
$new_height = floor( $height * ( 100 /
$width ) );
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// create a new temporary image
$tmp_img
=
imagecreatetruecolor(
$new_width,
$new_height );
// copy and resize old image
into new image
imagecopyresized( $tmp_img, $imgt, 0, 0,
0, 0, $new_width, $new_height, $width, $height
);
// save thumbnail into a file
imagejpeg(
"Images/thumb/".$filename );
$html=
src="Images/thumb/'.
$filename.'"></td>';

$tmp_img,

$html.'<td><img

}

If the GD library is available use it to generate a thumbnail image and save it on the server.
if($check==false)
{
$html=$html.'<td>'.$data[$i][$j].'</td>';
}

If the previous check was false, in other words if the column has not been set to be excluded, create an
html table column containing the column data for that row in the spreadsheet.
if($srcResults==0)
{
$html=$html.'<td><a
href="/google-docs-viewrecord.php?id='
$i.'">View Record</a></td>';
$html=$html.'</tr>';
}
else
{
$html=$html.'<td><a
href="/google-docs-viewrecord.php?id='.$srcResults[$i].'">View
Record</a></td>';
$html=$html.'</tr>';
}

If the page is not a page of search results build links to the individual records using their row position in
the $data array, if it is a page of search results build the links using values in the $srcResults array. This is
done because the $data array in a search results page is a subset of the total recordset so a records row
position in a search results page is not its row position in the data feed.
The prntRec function is a much smaller as it doesn't have the requirement to generate a thumbnail
image or exclude certain columns.
function prntRec($labels, $imgCols, $data, $count,
$id)
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{
$check=false;
$html ="";
for ($i = 0; $i < $count; $i++)
{
foreach ($imgCols as $imgCol)
{
if($i==$imgCol)
{
$check=true;
}
}
if ($check==false)
{
$html=$html.'<div
class="sub_content"><b>'.
$labels[$i].'</b><br>'.$data[$id][$i].'</div>
';
}
$check=false;
}
return $html;
}

The function accepts the parameters $labels – an array containing column names, $imgCols – an array
containing the id of all the image columns, $data – the array containing the data feed, $count – total
number of columns, and $id – the row number of the data row to be displayed. The function iterates
through the columns, checks whether or not they are image columns, and if they're not it displays that
column entry for the row identified by $id in a div. Images are displayed by a separate function
prntImgs which iterates through the image columns and outputs the URLs in html <img> tags, these
images are then displayed by the Galleria javascipt library in a js image gallery at the bottom of the
record page.

3.0 SUMMARY
In summary the application uses a CSV feed from a Google spreadsheet to provide a data source for a
simple PHP catalogue. Alternative methods for interacting with the spreadsheet are the Zend
framework Gdata PHP library or using a JSON feed. Both have their strengths and weaknesses, and Zend
is arguably a more powerful method as it interacts with Google's Data API allowing queries to be run
against the spreadsheet, but it does require a degree of server configuration to setup. As this is meant
to be as basic and low overhead an application as possible it was decided that it was a reasonable tradeoff to exchange Zend's power for CSV's simplicity and ease of installation.
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SETTING UP THE SPREADSHEET




Sign up for a Google account and click on Drive → Create → Spreadsheet
Click on the spreadsheets title to rename it
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The first row in the spreadsheet is the header row. This must contain your column
names (for a list of accepted column names see the Appendix).

Note on Images and Grid Coordinates:
Currently if you have images you wish to be displayed then you must put the link to your
external image host in a column labelled 'Image'. Most hosts, such as flickr and picasa, will
generate a link to an image for you, (see fig. below for example) – you must remember to
get the 'html code' version from hosts as
often the 'link' version doesn't provide a URL.
Links are accepted in two
forms, either html code
–
e.g.
<img
src
=
”http://yourphotos.imagehost.com/photos/photo.jpg”/> - or as a straight
URL –
e.g.
http://yourphotos.imagehost.com/photos/photo.jpg. In both cases the url must be
preceded by 'http://' and must end in '.jpg'.
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The system is capable of generating image thumbnails but it requires the GD
library to be
installed on your webhost. If this is not available then flickr auto-generates a thumbnail image
for each image uploaded and this will be retrieved instead. If neither of those options are
available then unfortunately no other means of generating a thumbnail is available at this
time.

Finally, currently only British National Grid coordinates are supported for generating google
maps for records and these must be put in a column labelled 'BNG'.


Once you have entered your column names drag the spacer bar (grey & white stripped
bar, top left) down to separate the first row from the rest of the sheet, fixing it in place



You can now establish validation rules if you wish. To this click on Data → Validation.
Validation rules ensure that the data being entered remains consistent. You can
validate against text, numbers or even set up a drop down list from users users can
select options when entering values into cells.

EPIP Photogrammetry recording
ArcHeritage Report

Report No 2013/26

ArcHeritage

36



You can now begin entering data. It is worth noting that as an alternative to manually
entering data you can import an existing spreadsheet into a Google spreadsheet and
either insert the data into a new sheet, overwrite an existing one or append to an
existing one. You must make sure though that if you have already set up column
names in the Google spreadsheet that they match up with the columns you have set
up in the sheet you are going to import, or be prepared for those column names to be
overwritten.



With the spreadsheet set-up and the data created it is now time to make it visible to
the web interface. To do this you must make the document public by going to File →
Share → Who has access and changing 'Private' to 'Public on the web'.
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Once made public you need to publish the spreadsheet to the web and then get a
copy of the URL. Click on File → Publish to the web... and ensure that under 'Sheets to
publish' the option 'Automatically republish when changes are made' checked and
then click 'Start publishing'. Then from the 'Get a link to the published data' section
select CSV from the first drop down list, copy the resulting link that appears and paste
it into a word processing program such as Notepad.
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CONFIGURING THE PHP
When setting up the PHP files there are only two variables that need to be considered, $file
and $excludeMask.
1. Open up the gsdb-php.php file, in Notepad it is found in the PHP sub-folder of the gsdb
app folder. In this file search (ctrl+f) for '$file'. It should point you to a line that looks
like this

$file=””;
This variable holds the URL you just copied in Step 8. Above that points to your Google
spreadsheet's CSV feed. Enter the URL between the quotation marks so you should
have something that looks like this

$file="https://docs.google.com/spreadshe
et/pubkey=0AoQQqCMa5wjdGhwb1dnbDExeVRYVEF
RdUNycXpNZmc&output=csv";

Now in Notepad click on File → Save As, then under Save as type choose 'All Files' and
for the name enter gsdb-php.php and click 'Yes' to overwrite existing files. With the
URL saved correctly you can close gsdb-php.php.
2. Now in the gsdb folder open up all_records.php in Notepad and search for
$excludeMask. It should point you at a line that looks similar to the following

$excludeMask=array(“New”, ”Description”,
“Image”);
This variable holds the list of columns which you do not want to be displayed on the
main records page. It is entirely up to you to decide what you wish to be displayed
(bearing in mind that trying to display every column will make the page incredibly
cramp and cluttered!). Every word in quotation marks and between the brackets is a
column name, so in the line above New, Description and Image are all column names.
If you wish to add a column name simply add a comma to the end of the list and enter
the name in quotation marks. If you wish to remove a name just delete it from the list.
So if in the above example we wished to add a column called 'Type' to the exclusion
list and remove the 'Image' column we would write the following

$excludeMask=array(“New”, ”Description”,
“Type”);
When you have set up the exclusion list to your satisfaction just click File → Save As,
then under Save as type choose 'All Files' and for the name enter all_records.php and
click 'Yes' to overwrite existing files.
The process is exactly the same for the search_records.php page which also has an
exclusion list.
Once you are happy that the PHP files have been configured as you wish it is simply a
matter of copying the gsdb folder to an appropriate location on your web host. For
most web hosts content you wish to be displayed on your website should be put in the
public_html folder, so if you're ensure as to where to copy the folder to simply put in
there and the catalogue will be available at yourwebsite/gsdb/all_records.php
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APPENDIX A
This appendix contains a list of standard column types. While column names not in this list will
be accepted, if you have a data type which fits into one of the categories below then it is
suggested you use the standard name for it.
Name

Type

Description

Album

Text

A column containing a link to a photo album

BNG

Text

A column containing British National Grid Coordinates for
the site or object being recorded

Description

Text

A column containing a brief summary description of the site

ID

Integer

Unique identifier number

Image

Text

Any column which contains the URL of an individual
image file

NMRS

Text

A column contain the sites NMRS number

Map

Text

A column containing a link to a pre-configured map

Site No

Integer

A column containing site identifier numbers

Sound

Text

A column containing a link to a sound file to be embedded in
the record

Type

Album

A column containing a site type value
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APPENDIX 3 - PROJECT BRIEF

East Peak Industrial Heritage Photogrammetry and Digital Recording Project Brief
(September 2012)
Summary
The East Peak Industrial Heritage Support Programme is a collaborative project between
English Heritage and the East Peak Innovation Partnership (EPIP) supporting communitybased industrial heritage activities in the East Peak area. The East Peak area covers North
Sheffield, Penistone, Kirkburton and Denby Dale (see area map attached). The programme
started in 2010 and finishes in 2013.
Over the past 18 months we have funded a range of activities that aim to support
community groups in understanding, promoting and protecting industrial heritage across
the East Peak.
We are currently looking to commission somebody to work with community groups across
the East Peak to help them to create sustainable on-line digital resources to record and
catalogue industrial heritage sites in their local areas, in ways that complement more
traditional recording techniques. The aim in each case will be to provide a sustainable
public resource that will help local groups not only to promote local industrial heritage to
new audiences, but also to record and monitor industrial heritage sites as part of their
ongoing conservation.
It is envisaged that the project will take the form of a series of practical workshops during
which local volunteers will visit and record sites in their local area, using photogrammetry
or other suitable digital modelling techniques. The contractor should then deliver
sufficient subsequent support sessions to ensure that the data collected can be hosted online in a way that can be freely accessed, managed and updated by the groups beyond the
life of the project.
Aims and Objectives
The main aim of the project is to work with up to 3 community groups within the East
Peak to help them to develop and maintain on-line, digital records of industrial sites from
their local areas, and to explore how different modern technologies can be used
effectively (and affordably) to record and monitor industrial heritage sites on a local scale.
The key objectives of the project are to:
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1. Deliver a series of practical workshops on the use of photogrammetry and other
techniques for digitally recording and modelling industrial heritage sites to 3 community
groups across the East Peak (a minimum of 3 days, or 6 half days, per group). These should
include at least one site recording visit, with follow-up technical support sessions.
2. Produce information sheets and/or guidance notes to accompany the workshops (to
help groups to continue to develop their skills in future) including advice on the use of
different techniques (or different software) and when these may or may not be suitable
for different sorts of groups and industrial heritage sites.
3. Oversee the development and launch of up to three new on-line industrial heritage
gazetteers or catalogues (which may be connected to existing websites or other on-line
collections) by each group, and advise the groups on ways of developing and continuing
their projects.
4. Review each group project after 6 months of completion to assess subsequent use and
assist with any further technical queries or problems encountered by each group.
5. Produce a final report on the whole project to advise other community groups and
potential funders as to what worked well, and the potential for developing similar projects
elsewhere in future. This report should include details of any problems encountered along
with advice on different approaches, copyright and software issues, data storage –
including any potential issues with the use of data clouds - and the potential for
commercial applications (for instance, by museums, heritage centres or charitable bodies)
so that the report is relevant to as many different sorts of heritage groups as possible.
Group projects
The project should work with:
1. The Roggins Local History group in Silkstone, to develop a free, on-line gazetteer of
features associated with the Silkstone Waggonway. As a minimum this should
include a 3D record of the different types of sleeper stone that are still visible
along the route (although other features may also be suitable for inclusion and this
should be decided in consultation with the group).
2. The Friends of Skelmanthorpe Textile Museum, to develop a free, on-line
gazetteer of artefacts (relating to the textile heritage of Denby Dale) that are on
display within the museum, as well as recording architectural aspects of the
museum building itself where possible.
3. The South Yorkshire Industrial History Society, to record and model the
Hoylandswaine Nail Forge for on-going monitoring and conservation purposes, and
to produce a free on-line model of the building and gazetteer of related ‘nailmaking’ objects. There are a number of historic artefacts within the forge itself
(including the surviving hearth and bellows) and these should all be recorded.
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Background information about all three sites, including photographs, will be provided in a
separate document. Silkstone Waggonway is open to the public and can be visited at any
time. The textile museum and the nail forge are only accessible by prior appointment. For
more details please contact EPIP.
Sustainability
This project is intended to create a sustainable resource that can be easily expanded,
updated and managed by local volunteers in the future. The contractor should therefore
ensure that, wherever possible, the techniques employed make use of technology that is
affordable and accessible to all community groups and volunteer organisations (including
those with little or no external funding).
Different approaches (including the use of different software or hosting platforms) may be
considered to be more, or less, suitable for different projects, and the choice of
methodology and its success (or otherwise) should be recorded as part of the final
assessment report.
Copyright and permissions
The training delivered to each group should include advice on copyright and ethics, data
storage and data protection. The successful contractor must ensure that any groups
involved with the training have permission to host all materials produced on-line, and to
make these materials freely available to the general public under a creative commons
license.
The contractor will be responsible for making sure that any necessary consents (written or
otherwise) from groups and individuals - including site owners and the owners of imaging
software - have been obtained in order to allow these permissions to be given. Copies of
these consents must be provided to EPIP where relevant.
The final report must be submitted in both paper and digital copy (as a word document
and pdf). A minimum of four paper copies should be submitted. The contractor should
also give EPIP and project partners (including English Heritage, Barnsley Museums and
Sheffield Industrial Museums Trust) permission to reproduce and circulate the final report,
including making it freely available on the internet.
Timescale
The main workshops should be completed by the 31st December 2012. The review
sessions should be carried out within 6 months of the final workshops and the final report
submitted to EPIP and English Heritage for comments within one month of this. The final
version of the report should be completed by 15th September 2013 at the latest.
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Contact
The contact for the programme is Tegwen Roberts, Industrial Heritage Support Officer at
EPIP (contact details below). For more information about the programme and other
funded work please visit our website - http://industrial-heritage.epip.org.uk/
Quote
Please provide a written quote for the above work, including a detailed break-down of the
proposed costs, timetable and methodology. Please also include a summary of relevant
previous work and experience, along with any supporting documents, by 5pm October 3rd
(2012). Quotes should be sent to:
Tegwen Roberts
East Peak Innovation Partnership
Town Hall House
Shrewsbury Road
Penistone
S36 7DY
Please mark the envelope ‘tender submission’ and include your name on the back of the
envelope.
If you have any queries about this document please contact Tegwen on 01226 767365 or
by e-mail at tegwen@epip.org.uk
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Appendix 4 – Method Statement
A1.1

Standards

ArcHeritage is an IfA Registered Organisation. All work will be carried out in accordance with
the IfA Code of Practice, and relevant Standards and Guidance documents, the Brief and this
Methodology.
A1.2

Set-up

The first stage of the project will involve a set-up meeting with the EPIP Industrial Heritage
Support Officer. Meetings (or liaison by phone, if time constraints dictate) will then be held
with representatives from the three groups to discuss the format and content of the
workshops, and to arrange training venues. We anticipate that EPIP and the groups will be
able to assist with the selection and booking of suitable venues.
A1.3

Software co-ordination and teaching materials

Following the set-up meeting with each group, the necessary software purchases/downloads
will be made for each group, after deciding their needs and how they want to progress.
Relevant teaching materials, again tailored for each group, will be produced. These will
provided in printed format for workshop sessions, and also supplied on CDROM for
subsequent distribution. Teaching materials will be distributed prior to the workshops.
A1.4

General approach and tailored workshops

Each group will need a slightly different approach, suitable for their site and data types. A
series of workshops will be delivered for each group. The suggested format is outlined below,
subject to the agreement of each group. We welcome discussion on these suggestions.
Roggins Local History Society
The Roggins group has already been successfully collecting data for the waggonway, following
completion of the archaeological report. We propose to assess their current data collection
techniques (GPS data and photogrammetric images) and establish the best ways to present
the data publicly. We suggest the use of Google Maps or HistoryPin as a mechanism for
showcasing the most interesting features along the waggonway. These could include areas of
damage or concern, to raise public awareness about the condition of the monument. We will
show the group how to create geotagged digital images for inclusion on these websites.
We will also create additional pages for their existing website, to host an on-line catalogue,
with links to images, 3D PDF files and descriptive text.

Full day
(site and
classroom)



morning site visit for refresher on collecting images for
photogrammetry. Collecting geotagged images using low cost mobile
phone app (e.g. GPS4cam) and standard digital cameras



afternoon session to retrieve data, learn how to manipulate and re-
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size images using free image software (e.g. GIMP), process geotagged
digital images and upload into mapping programme or shared sites
(e.g. Google maps, Flickr)

Full day
(classroom)

Half day
(classroom)
Half day
(classroom)



cover issues surrounding copyright, permissions, data storage



assessment of 123D Catch (free software currently being used by the
group) compared to AgiPhotoscan (relatively low cost, but with more
secure future potential) to determine the most suitable long-term
sustainability of the data



use of photogrammetric software, creation and cropping of 3D
models, production of 3D PDF files for upload to Roggins website



use of shared database (e.g. Google Drive) to upload data to website.
Creating links to other image locations (e.g. Flickr)



use of other web-based sites for sharing and curating data (e.g.
HistoryPin)



additional training in updating of online gazetteers/catalogues



additional training in updating of online gazetteers/catalogues

The Friends of Skelmanthorpe Textile Museum

The interior of the museum is likely to be too complex for photogrammetric modelling.
Instead, we will experiment with the creation of a complete panoramic view of the
interior, in which ‘hot spots’ are linked to certain artefacts (and architectural features of
interest) which form the online catalogue. The HistoryPin website would also be an
excellent mechanism for curating a collection of photographs and text.
Full day
(site and
classroom)

Full day
(classroom)

Half day
(classroom)
Half day
(classroom)



morning site visit for collecting images for panoramic view of interior,
and a selection of individual artefact images/descriptive text for the
artefact catalogue. Record selected architectural features of the
building by digital photography/descriptive text



afternoon session to retrieve data, learn how to manipulate and resize images using free image software (e.g. GIMP)



use of shared database (e.g. Google Drive) to upload data to website.
Creating links to other image locations (e.g. Flickr)



cover issues surrounding copyright, permissions, data storage



use of software (e.g. Pano2VR) to create artefact hotspots in the
panoramic view of the museum, linked to the online catalogue



additional training in updating of online gazetteers/catalogues



use of other web-based sites for sharing and curating data (e.g.
HistoryPin)



additional training in updating of online gazetteers/catalogues



additional training in updating of online gazetteers/catalogues
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South Yorkshire Industrial History Society
The SYIHS has a website to which additional pages could be added for the Hoylandswaine Nail
Forge. Models of the exterior and interior will be created through photogrammtery. These will
be joined together (requiring a small amount of Total Station survey) to allow a slice through
the building to be viewed. These three models will be animated by ArcHeritage, to be placed
on the website by the group.
A simple mechanism (e.g. 2D mapping, with location spots) will be generated following the
workshop session with the group. This will be used to identify the locations of features which
the group select for inclusion in the online catalogue. The group can then choose whether to
record some of the internal features using photogrammtery or normal photography, for
inclusion in the catalogue.
Full day

Full day

Half day
(classroom)
Half day
(classroom)



on site collecting images for exterior and interior photogrammtetric
modelling of building. Including use of Total Station to enable the
interior to be tied to the exterior model. Decide which interior
features/artefacts are suitable for individual modelling. Collection of a
sample of artefact images to use in the classroom session.



assessment of 123D Catch (free photogrammetry software) compared
to AgiPhotoscan (relatively low cost, but with more secure future
potential) to determine the most suitable long-term sustainability of
the data



use of photogrammetric software, creation and cropping of 3D
artefact models, production of 3D PDF files for upload to website



cover issues surrounding copyright, permissions, data storage



learn how to manipulate and re-size artefact images using free image
software (e.g. GIMP).



use of shared database (e.g. Google Drive) to upload data to website.
Creating links in the catalogue to other image locations (e.g. Flickr)



use of other web-based sites for sharing and curating data (e.g.
HistoryPin)



additional training in updating of online gazetteers/catalogues



additional training in updating of online gazetteers/catalogues
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Screen shot from the HistoryPin website

A1.5

Support from the groups

We would need the following support from the groups to ensure the smooth running of the
project:


contacting members to help schedule workshops and booking suitable venues



information/contact details for each group’s website host, to facilitate the integration
of the new web resources

A1.6

Sustainability and support

The project outputs are designed to be sustainable into the future. A certain amount of initial
set-up, data processing and support will be provided by ArcHeritage to enable the groups to
progress their projects. This will include:


basic website/catalogue set up, including new web pages and links to Google Drive, as
appropriate (all groups).



limited Total Station survey (with group participation) for Hoylandswaine Nail Forge
(SYIHS) to facilitate joining photogrammetric models of interior/exterior of the
building.



processing photogrammetric data and stitching together interior/exterior for the
model of the Hoylandswaine Nail Forge (SYIHS). Animating three models (exterior,
interior and cutaway view).



written teaching materials (all groups).
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Review

A review will be carried out in June 2013. The review will establish the effectiveness of the
approach for each group. We will seek feedback for all of the workshops via forms to be
completed by participants. We will also request written and/or verbal feedback from
participants from each group about the project in general. The results of the feedback will be
synthesised for incorporation into the final report. The review may also result in small
amendments to the teaching materials or advice given to the groups, to support their ongoing
work.
A1.8

Reporting

A written report will be produced. This will detail the methodologies used, and the results of
the review. The report will cover any issues encountered, and how these were resolved. It will
discuss the suitability of the methodology for future projects elsewhere. The report will
provided in hard copy (4 copies) and in PDF format on CDROM.
A1.9

Archive and deposition

An archive will not be generated by this project.
A1.10 Copyright
We will ensure that the groups obtain the correct permissions for the use of images etc during
the life of the project, and that they know the appropriate procedures for continuing to obtain
data permissions etc for the long term.
ArcHeritage will give permission for the material presented within any reports, and other
documents produced as part of this project, to be used by the client (EPIP) and any other party
in perpetuity, although ArcHeritage retains the right to be identified as the author of all
project documentation and reports as specified in the Copyright, Designs and Patents Act 1988
(chapter IV, section 79).
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